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Exporting is the process used to extract selected information from your Financial Edge database to use in another 
software application. You can export data from each program in The Financial Edge to update or view in an 
application outside of The Financial Edge. For example, you can export data to analyze or manipulate in a 
spreadsheet program or to create a custom report. 

The export process consists of identifying information to extract from your Financial Edge database, determining 
the file format for the information, and transferring the information to a specified location. While the processes 
and capabilities of Query and Export overlap, Export is a more advanced data extraction and reporting tool. It can 
better organize one-to-many relationships and other complicated types of data into simpler formats. For more 
information about queries, see the Query Guide for The Financial Edge.
The security settings you establish in Administration apply to Export. For example, if you prohibit data entry clerks 
from viewing budgets, they cannot export budget information in Export. If you deny a group access to all Export 
options, Export does not appear on the navigation bar for those users.

Accessing Export Records

The Export page contains the commands necessary to complete all exporting functions. From this page, you can 
find, add, open, delete, and run exports. 
To access the Export page, select Export from the navigation bar. The Export page appears.

Note: Visit our Web site at www.blackbaud.com for the latest documentation and information.

Note: Exporting is the process used to extract selected information from your database to use in another 
software application. 

Tip: You can add Export favorites to the navigation bar, home page, or Favorites menu. For more information 
about using favorites, see the Program Basics Guide.
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Finding and Opening Export Records

To open export records from the Export page, in the grid, double-click an export, or select one and click Open. 
There are several tools you can use to locate saved export records. You can use the Type and Format fields to 
filter the grid by export type or export format, or mark Only show my exports to display only the exports you 
created. You can also search for saved exports using the Find button on the action bar. 

Locating and opening an export record using the Find button
1. From the navigation bar, select Export. The Export page appears.

2. Click Find. The Find screen appears.

3. In the Field field, select a search category such as “Name” or “Export type”.
4. In the Find what field, enter specific field information you want to find. For example, if you entered 

“Name” in the Field field, you can enter the first three letters of the name to narrow the search.
5. In the Match field, select the part of the field to search. 
6. To find only records with identical upper and lower case characters, mark Match case.
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7. When you have entered your search criteria, click Find First or Find Next. The program selects the first or 
next record matching your criteria. 

8. Once you locate the export, select it and click Open. The selected export record appears.

9. On the export record, you can view information or make changes.
10. To save the export record and return to the Export page, click Save and Close.
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Parts of an Export Record
You create an export by setting parameters in the export record. The export record consists of two tabs, the 
Filters and Output tabs, where you identify specific output fields and criteria, and select which records to export. 

Filters Tab

On the Filters tab, you select criteria that determines which records to include in an export. For example, to 
create an account export that includes only expense accounts, on the Filters tab, choose Selected in the Include 
column for Categories. The Selected Categories screen appears on which you select the Expense category. By 
selecting the Expense category, all other account categories are “filtered out”, and only expense accounts are 
included in the export. For more information about filtering criteria, see the Program Basics chapter of the 
Program Basics Guide. 

Output Tab

On the Output tab, you select fields from a tree view that correspond with data you want to include in the export. 
The Output tab consists of the Available Fields box and the Output box. You can resize the two boxes, and you 
can drag and drop fields back and forth between the two boxes.

Note: If you want to include all records in the export, you do not need to use the Filters tab. For new exports, 
all records are included by default.

Glossary: A criteria group in Export is a set of related fields from the same record type. For more information 
about criteria groups, see “Using Criteria Groups” on page 15.
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The Available Fields box contains a tree view of all criteria groups available for the export type you selected. You 
can narrow the fields listed in the Available Fields box by selecting a specific criteria group in the field located 
above the box, which defaults to <All>. 
Each criteria group contains related fields you can add to the export. To view the related fields, click the plus sign 
next to the criteria group. For example, in an account export, Notes is one available criteria group. Click the plus 
sign next to Notes and several related fields appear, including Author, Date Added, and Last Changed By. 

To add a field to the Output box, select a field from the tree view in the Available fields box, and click Select. Two 
quicker methods are to double-click fields or to drag and drop fields from one box to the other. When you select 
certain fields to export, field-specific output criteria screens appear where you can define additional 
characteristics records must meet to be included in the export. For more information about output criteria 
screens, see “Output Criteria Screens” on page 20.

Output Tab Buttons

There are several buttons on the Output tab you can use to select information for an export. Use the up and 
down arrows to search for items in the Output box. Use the Next and Back buttons to move back and forward 
between the Output tab and Filters tab.
Find. Use the Find button to search for values in the tree view in the Available Fields box.
Select. Use the Select button to select fields to export. If you select a field that is a one-to-many group or 

summary, a field-specific output criteria screen appears. If you select a one-to-one field, the field is moved to 
the Output box. For more information about output fields, see “Understanding Export Output Fields” on 
page 15.

Tip: When adding fields to the Output box, the quickest methods are to double-click fields or to drag and drop 
fields from one box to the other.

Note: Creating an export using the Blackbaud Conditional Word Merge or Blackbaud Simple Word Merge 
export format adds extra buttons to the toolbar for these functions. For more information about conditional 
and simple merges, see “Using the Word Merge Process in Export” on page 31.
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Remove. Use the Remove button to remove selected fields from an export.
Criteria. Use the Criteria button to view criteria for a selected field. This button is enabled only when you select 

a one-to-many group or a summary field in the Output box.
Cancel. Use the Cancel button to exit the Output tab or the Filters tab. The program returns to the Export page 

without saving changes.
Export Now. Use the Export Now button to process an export. 

Export Types

The first step in the export process is to select a record type to export. Each export can include only one export 
type, and the fields included in the export are only those related to that record type. For example, if you select to 
create a General Ledger Account export, only fields found on account records are available to export. You select 
the export type on the Create a New Export screen.

You can create these export types in The Financial Edge:

Note: When editing an export file associated with a Custom Report, the Remove button is disabled. You cannot 
delete any fields in an export used in a Custom Report.

Tip: You can set a default export type in Options.
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Export Formats

You must also select a format for data exported from your database. The export format determines how data 
appears in the data file and the application with which it is used. Export formats are especially important for 
exported information you plan to update in another application and then import back into The Financial Edge. In 
Options, you can assign a default export format to use when creating new exports. 

Financial Edge Export Types

General Ledger
Account
Project (With Projects and Grants 
installed)
Transaction
Recurring Batch
Grants

Accounts Payable
Vendor
Invoice
Purchase Order (With Purchase Orders 
installed)
Credit Memo
Receipt
Payment
Product
Recurring Invoice
Bank 
Bank Adjustment (With Cash Management 
installed

Fixed Assets
Asset
Transaction

Accounts Receivable
Client
Charge
Credit 
Deposit
Invoice
Payment
Product and Billing Item
Recurring Invoice
Refund
Return
Transaction

Cash Receipts
Deposit
Payment

Student Billing
Advance Deposit
Billing Schedule
Charge
Credit
Deposit
Financial Aid
Individual
Organization
Payment
Product and Billing Item
Refund
Student
Transaction

Note: An export format determines the way exported data appears and the software application with which it 
is used. Export formats include Microsoft Excel, Microsoft Access, and Lotus 1-2-3. 



EX P O R T 9
If you select to use the Blackbaud Simple Word Merge or Blackbaud Conditional Word Merge export format, you 
can use a wizard to merge information from an export file with a Word document template. For more 
information about creating merges, see “Using the Word Merge Process in Export” on page 31.
If you plan to use the export file in Custom Reports to create a custom Crystal report, use one of these *.MDB 
formats: Blackbaud Report Writer Database, Microsoft Access 2.x Database, Microsoft Access 95 Database, 
Microsoft Access 97 Database, or Microsoft Access 2000 Database. For more information about using Custom 
Reports, see the Reports Guide for that program.
You select the export format on the Create a New Export screen or on the Export Options screen. For more 
information about the Export Options screen, see “Export Styles” on page 10.

The export formats available in Export include:

Additional Fields and Options For Export Formats

Additional fields and options appear on the Create a New Export screen depending on the export format you 
select. 
Include Header. If you select Character Separated Values or Microsoft Word Merge File as the export format, 

the Include Header checkbox appears. Mark this option to include the output field names as column headers. 
We recommend using column headers for exports of records you intend to update in another application and 
then import back into The Financial Edge.

Separator. If you select Character Separated Values as the export format, the Separator and Qualifier fields 
appear. In the Separator field, select the character value, such as a comma, you want to use to separate field 
data in the export. For example, this is a row of project data from a character separated data file, using 
commas as the separators:
Supervisor,01/08/2002,Rogers Endowment,1008,Endowment

Tip: You can set a default export format in Options.

• Blackbaud Conditional Word Merge • Internet Document (HTML)

• Blackbaud Report Writer Database 
(MDB)

• Lotus 1-2-3 (WK1)

• Blackbaud Simple Word Merge • Lotus 1-2-3 (WK3)

• Blackbaud XML Export (XML) • Microsoft Access 2.x Database

• Character Separated Values • Microsoft Access 95 Database

• Comma-Separated Values • Microsoft Access 97 Database

• dBase III • Microsoft ADO Recordset 2.1 
(ADO)

• Excel 3.0 (XLS) • Microsoft ADO XML Recordset 2.1 
(XML)

• Excel 4.0 (XLS) • Microsoft Word Merge File

• Excel 5-7 (XLS) • Rich Text Format Microsoft/Word 
Table (RTF)

• Excel 97-2000 (XLS) • Text

• FoxPro Database • WordPerfect Merge File
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Qualifier. In the Qualifier field, specify the character to use, such as a quotation mark, to distinguish punctuation 
from character separators. For example, you have a comma that separates the city and state in an address 
field. Without a qualifier, the program may think the comma indicates a new field. By placing a text qualifier at 
the beginning and end of your field, the program knows all text contained between the text qualifier is part of 
the same field. In this example, the text qualifier is quotation marks:
"Party Rent-All","Active","643 Main St.<cr>Mt. Pleasant, SC 29464"

Export one-to-many records. If you select Microsoft Access 2.x Database, Microsoft Access 95 Database, or 
Microsoft Access 97 Database as the export format, the Export one-to-many records checkbox appears. To 
use a relational style, mark the checkbox. To use a flat style, leave the checkbox unmarked. The following 
section discusses relational and flat styles in greater detail.

Export Styles

Export style is a term used to describe how extracted data is presented in the data file. In The Financial Edge, 
there are two export styles you can use, flat style and relational style. Most export formats present only the flat 
style view of data, but the Blackbaud Report Writer and Blackbaud XML Export formats use only the relational 
style. Furthermore, for the Microsoft Access 2.x Database, Access 95 Database, and Access 97 Database export 
formats, you can use the relational or flat style. For more information about export formats, see “Export 
Formats” on page 8.
On the Export Options screen, you can change the export format and style independently of each other, for a new 
or previously saved export record. You can also change the export name and description, and the VBA macro 
used. To access the Export Options screen, select Tools, Export options from the menu bar of the export record 
screen. For more information about using VBA macros in Export, see the VBA help file. To access the VBA help file, 
from the menu bar, select Help, FE:VBA Help.

Flat Style Exports 

Most export formats support a flat style view of data. In this style, the export displays information in grid format 
where each row contains a different record and each column displays a field within that record. For example, in 
an account export, each row displays all the field information extracted for the account. 

Glossary: Export style describes how data in the data file is presented. In The Financial Edge, there are two 
export styles you can use, flat style and relational style.

Glossary: In a flat style view of data, the export displays information in grid format where each row contains a 
different record and each column displays a field within that record. 
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Flat style exports are used most often for creating simple Crystal reports. For more information about creating a 
flat style export, see “Creating an Export” on page 21.
There are two tools you can use to help you visualize the final output of a flattened export data file. First, select 
View, Export field names from the menu bar to view the column header name assigned by the program to each 
field selected for exporting. When you select this view option, the field names in the Output box change and 
become their column header name. 
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Once you have identified the header names, you can view a sample of your data file by selecting File, Preview 
Export File from the menu bar. The Preview Export File Layout screen appears displaying a grid view of the first 
fifteen rows of the export. Data is arranged in rows and columns as it will appear in the actual export. The column 
headers you viewed in the Output box are the column headers used in the grid. A field at the bottom of the 
screen displays the number of columns that will appear in your export. 

Relational Style Exports

Note: A relational style export is an export in which the information for each selected criteria group is 
displayed in a separate table. Each row in the table may or may not correspond to a separate record. 
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A relational style export is an export in which the information for each selected criteria group is displayed in a 
separate table. Each row in the table may or may not correspond to a separate record. For example, if you export 
the account and budget information shown below in relational style, each of the two groups appears in its own 
separate table rather than all in one grid as it would in a flat style export.

A relational style export of these criteria groups creates three tables: a key table to define how records are linked, 
a table with account information, and a table for the budget information. 
The pictures below show each of the tables as they appear when created in a Microsoft Access Database format. 

Note:  Unlike flat style exports, relational style exports can include an unlimited number of records. Therefore, 
specifying the number of records to export on an output criteria screen is optional.
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Table 1: The Key Table — defines how records are linked

Table 2: Budget Information
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Table 3: Account Information

You can use the relational style for these export formats: Blackbaud Report Writer, Blackbaud XML Export 
formats, Microsoft Access 2.x Database, Access 95 Database, and Access 97 Database.
Blackbaud Report Writer and the Blackbaud XML Export formats automatically use the relational style. To use the 
relational export style for the Access export formats, mark Export one-to-many records in separate tables on the 
Create a New Export screen or on the Export Options screen. To access the Export Options screen, select Tools, 
Export Options from the menu bar of the export screen. 

Understanding Export Output Fields

You have many options when deciding the type of information to export. Certain output fields have additional 
formatting options. For example, you can set up multiple criteria groups for one-to-many and summary fields, 
and specify filtering criteria for the entire group. If you export batch information, you can create a criteria group 
for total batch amount that is filtered to include only transactions in the current month. You can then create a 
second total batch amount criteria group filtered to include only transactions in the previous month. 

Using Criteria Groups

Criteria groups in Export are groups of related fields from the same record type. For example, the Account criteria 
group contains only fields found in an account record.
The Output tab of an export record displays all the criteria groups in the Available Fields box. There are three 
types of criteria groups: one-to-one groups, one-to-many groups, and summary groups. The terms one-to-one, 
one-to-many, and summary illustrate the relationships between fields within criteria groups. 

Note: Output fields are the fields you select to include in your export. These fields correspond to fields found in 
The Financial Edge. 

Note: A criteria group in Export is a set of related fields from the same record type. 
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One-to-One Criteria Groups

A one-to-one criteria group is composed of fields for which only one value exists in your database. For example, in 
an account export, the Account group contains fields such as Account number, Description, and Class. This group 
qualifies as a one-to-one criteria group because each of these fields can have only one assigned value on an 
account record.
You can identify one-to-one criteria groups in two ways. First, in the Available Fields box, each one-to-one 
criteria group is designated by an icon depicting a single table. Second, when you select an output field from a 
one-to-one criteria group, the Criteria button is disabled and you cannot assign any additional criteria to the 
group. 

One-to-Many Criteria Groups

Note: A one-to-one criteria group is composed of fields for which only one value exists in your database. 

Note: A one-to-many criteria group is composed of fields for which several values exist in your database. 
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A one-to-many criteria group is composed of fields for which several values exist in your database. For example, 
in an account export, Budgets is a one-to-many criteria group because each budget can be associated with more 
than one account. You can identify one-to-many criteria groups in two ways. First, in the Available Fields box, 
each one-to-many criteria group is designated by an icon depicting multiple tables. 

Second, when you select an output field from a one-to-many criteria group, an output criteria screen appears 
with additional filtering options specific to that criteria group. For more information about criteria options, see 
“Output Criteria Screens” on page 20.

Summary Criteria Groups

A summary criteria group is composed of fields of calculated data rather than field information that is available 
directly from the database. For example, in an account export, there are two summary criteria groups: Summary 
and Budget summary. The Summary criteria group contains fields for beginning balances, ending balances, and 
net assets calculations.

Note: A summary criteria group is composed of fields of calculated data rather than field information that is 
available directly from the database. 
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Like one-to-one criteria groups, in the Available Fields box, each summary criteria group is designated by an icon 
depicting a single table. However, unlike one-to-one criteria groups, when you select an output field from a 
summary criteria group, an output criteria screen appears with additional filtering options specific to that criteria 
group. For more information about output criteria screens, see “Output Criteria Screens” on page 20.

Using Multiple Criteria Groups of the Same Type
In Export, you can define multiple criteria groups for one-to-many and summary fields. This means that you can 
define multiple instances of the same group type, each with its own unique filtering criteria. This feature is useful 
for comparing similar items. For example, you can create an account export that compares this year and last 
year’s ending balances for the previous fiscal period. 

Creating multiple criteria groups of the same type
1. After selecting Account group information for the export, in the Available Fields to Export box, select the 

Ending Balance field in the Summary group. The Ending Balance output criteria screen appears on the 
General tab. For more information about output criteria screens, see “Output Criteria Screens” on 
page 20.

2. In the Fiscal year field, select “This fiscal year”.
3. In the Period field, select “Last fiscal period”.
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4. Click OK. The Ending Balance group now appears in the Output box. 

5. For the second criteria group, in the Available fields box, select the Ending Balance field again. A screen 
appears to notify you that this field already appears in a group and asks if you want to add a new group. 

6. Click Yes. The Ending Balance output criteria screen appears on the General tab.
7. In the Fiscal year field, select “Last fiscal year”.
8. In the Period field, select “Last fiscal period”.
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9. Click OK. The second Ending Balance group now appears in the Output box.

10. Continue to add more fields, or click Export Now to run the export.

Output Criteria Screens

In an export record, when you select to export fields from one-to-many or summary criteria groups, an output 
criteria screen appears. On this screen, you can define additional characteristics records must meet to be 
included in the export. 

Note: You can also use the Criteria button in the Output box to access an output criteria screen for any 
one-to-many or summary criteria group.
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The type of criteria screen that appears depends on the field you select. For example, in an account export, if you 
select a field in the Transactions criteria group, the Transactions criteria screen appears. On the General tab, you 
can select the number of transactions to export for each account, define a date range of transactions to include, 
and select the type of transactions to include. On the Filters tab, you can filter by several types of transaction 
filters. Selections made on the Filters tab apply to only the items in the criteria group, not the entire export. Not 
all output criteria screens have a Filters tab.

Multiple criteria screens appear when you select certain export fields. For example, in a client export, if you select 
a field in the Phones criteria group (found in the Address criteria group), two criteria screens appear — one for 
specifying how to export addresses and one for specifying how to export contact information.

It is important to use the correct number in the number to export field. For example, you can create a client 
export including all payers responsible for each client. To do this, select the Payer name field. On the criteria 
screen, in the number to export field enter the highest number of payers a client might have, for example 4. This 
export produces a list of clients and their associated payers. If a client has only one payer, only one is listed for 
that client. If a client has four payers, four payers list for that client.

Creating an Export
Using Export, you can extract records from your database to use in other applications. For example, once you 
export a file of records, you can edit it in Excel, and then import the file to back into The Financial Edge to update 
the database. The appearance of export data files may differ depending on the export format and style you select 
to use. You can use a control report to view or print information about the data included in the export. The 
following procedure guides you through creating an account export in a comma-separated values format.

Warning: When using multiple criteria groups of the same type, to ensure that each column of exported 
information contains only one type of data, it is very important to use the correct number in the number to 
export field. 
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Creating an export
1. From the Export page, click New. The Create a New Export screen appears.

2. Select the export type and the export format. For this example, we create an account export in 
comma-separated values format. For more information about export formats, see “Export Formats” on 
page 8.

3. If you select “Comma-Separated Values”, “Character Separated Values”, or “Microsoft Word Merge File” 
as the export format, the Include Header checkbox appears. Mark this option to add column headers for 
the fields included in the export.

Note: On the Export Options screen, you can change the export format and export style independently of each 
other at any time. For more information about the Export Options screen, see “Export Styles” on page 10.

Note: We recommend using column headers for exports of records you intend to update in another 
application and then import back into The Financial Edge.
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4. Click Create Now. The New Account Export screen appears displaying the Filters tab.

5. Select criteria to determine which records to include in an export. For this example we filter by selected 
account numbers.
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6. Select the Output tab.

7. In the Available Fields box, a tree view lists all the criteria groups available for the export type you are 
creating. Click the plus sign next to a criteria group to view all of the fields available for that criteria 
group. For more information about criteria groups, see “Using Criteria Groups” on page 15.
For this example, we expand the Account criteria group.

Tip: When adding fields to the Output box, the quickest methods are to double-click fields, or to drag and drop 
fields from one box to the other.
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8. To add fields from the tree view to the Output box, select the field and click Select. The field moves to the 
Output box. For this example, we add the Account number field. 

You must have the appropriate security rights to output credit card, bank account, and Social Security 
numbers. If you have rights, when you add these fields to the export file, a screen appears where you can 
select whether the numbers should be masked or unmasked in the export file. If you do not have rights, 
these numbers are always masked in the export file. For more information, see the Security chapter of 
the Administration Guide for The Financial Edge.

Note: We recommend including import IDs in exports of records you intend to update in another application 
and then import back into The Financial Edge.
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9. Continue until you have added all the fields you need for that criteria group.

10. Expand the next criteria group with fields you want to export. For this account export, we expand the 
Budgets criteria group.

Tip:  In Options, you can set default values to export for yes/no fields.
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11. Select a field from the criteria group to add to the Output box. For this example, we select the Amount 
field. The Budgets output criteria screen appears.

Because Budgets is a one-to-many criteria group, when you select a field from the group, an output 
criteria screen appears. On output criteria screens, you define additional characteristics records must 
meet to be included in the export and determine the number of items to export per record type. Criteria 
set on the Budgets output criteria screen applies to all fields added to Budgets criteria group. For more 
information about output criteria screens, see “Output Criteria Screens” on page 20.

12. Enter a number in the For each Account, enter the number of budgets to export field. 

For this example, we enter “1”. For more information about using the number to export field, see 
“Output Criteria Screens” on page 20.

13. Select a budget scenario in the Scenario ID field.
14. Select a year in the Fiscal year field.

Note: A one-to-many criteria group is composed of fields for which several values exist in your database. For 
more information about one-to-many criteria groups, see “One-to-Many Criteria Groups” on page 16. 

Note: When using multiple criteria groups of the same type, to ensure that each column of exported 
information contains only one type of data, it is very important to use the correct number in the number to 
export field. For more information, see “Using Multiple Criteria Groups of the Same Type” on page 18.
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15. Select an item to sort by in the Order by field, and mark Ascending or Descending for the sort order.

16. Click OK and you return to the Output tab. The Amount field appears in the Output box.
17. Continue adding fields until you have added all the fields you need for the Budgets criteria group. 

18. To print or preview a control report listing the selected criteria groups, output fields, and field header 
names for the export, mark Create Control Report and select Print or Preview. The control report prints 
or previews after the export processes.
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19. To preview a sample of your data file, select File, Preview Export File from the menu bar. The Preview 
Export File Layout screen appears displaying a grid view of the export. 

20. Click Close to exit the preview screen. You return to the Output tab.

21. Click Export Now to run the export. The Export file name screen appears.

22. Browse to the location where you want to save the exported data file and enter a file name in the File 
name field.

23. Click Save. You return to the export record and processing screens appear. When the export finishes, a 
screen appears telling you the number of rows exported and the time elapsed. 

Tip:  In Options, on the File Locations tab, you can define default file locations for export files.

Tip:  In Options, you can set the program to save export records automatically. 
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24. Click OK. If you selected to preview a control report, the control report screen appears. 

25. Click X to exit and return to the export record.
26. Click Save and Close. The Save Export As screen appears. 
27. Enter a name and description for the export record and mark if other users can run or modify this export.
28. Click Save. You return to the Export page.

Running an Export from the Export Page
You can use saved export records as templates for exports you run frequently. For example, if you use an Excel 
spreadsheet to track the activity of certain accounts at the end of each month, you can create an account export 
with the activity of selected accounts. At the end of each month, you can run the saved account export to update 
the spreadsheet with the specified account information. 
To save time, you can run an export directly from the Export page without having to open the export record. This 
function makes it quick and easy to update an export data file to include new data entered into the database 
since the last time you ran the export. 
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Running an export from the Export page
1. From the Export page, select the export to run and click Export. The Export file name screen appears.

2. The export’s data file name appears in the File name field. You can either overwrite the existing data file 
or save the updated data file as a new record.
To overwrite the existing data file with the updated data file, click Save. A message screen appears asking 
if you want to replace the existing file. Click Yes.
To save the updated data file as a new record, enter a new name in the File name field and click Save.

3. A processing screen appears. Once the export finishes processing, message appears indicating the 
number of rows exported and the elapsed time. Click OK and return to the Export page.

Using the Word Merge Process in Export

Export is integrated with Microsoft Word features so you can use information exported from your Financial Edge 
database to create custom documents such as form letters, mailing labels, envelopes, and mass e-mail and fax 
distributions directly from Export.
The merge process consists of merging a document template, such as a form letter, with variable information 
exported from The Financial Edge. This process produces documents with the same basic format and text, yet 
each individual document is customized with specific Financial Edge information. For example, you can create a 
form letter to send to all accounts receivable clients notifying them of an increase in costs for services. The text of 
the letter is essentially the same for all clients, but the address section is customized with the recipient’s name, 
address, and account number.
You can create two types of Word merges in The Financial Edge, simple and conditional.
• Simple merges produce a series of documents using the same document template, customized with 

information exported from The Financial Edge.
• Conditional merges create a series of documents using multiple text formats, customized with fields of 

information exported from The Financial Edge, that differ based on specified conditions.
The procedures in this section guide you through creating simple and conditional merges in Export.

Warning:  You must have Word 2000 or Word XP installed on your computer to create Word document merges 
in The Financial Edge. 
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Creating a Simple Word Merge

Use the simple merge process to merge an export file with a single document template to produce a group of 
documents customized with fields of information exported from The Financial Edge. For example, in General 
Ledger, you can create memos to send to project contacts. The text and format of the memos are exactly the 
same, but the project balance and budget information each memo contains is specific to the project the recipient 
is assigned to. 
This is an overview of the process you would use to create the project memos described in the previous example:

Step 1. In Word, create the document template for the memo, leaving placeholders where you want to later 
include data.

Step 2. In Export, set up the export. Select the Contact name, Address, and Project ID fields.
Step 3. Click Edit merge file on the toolbar to access Word. Insert the document template you created in step 1 

into the blank Word document.
Step 4. Insert the field names you included in the export file into the placeholders created for that information. 

For example, if you left a placeholder for the project contact name, insert the Contact name field.
Step 5. Return to the export record and run the merge. A Word file containing the merged documents is saved in 

the location you designate. You can preview these documents and make necessary changes before saving the 
export record.

Creating a simple merge in Export
1. Once you complete the planning of your documents, open Word. 
2. Create the document template by typing the document in Word, leaving placeholders for the fields of 

information to add later. For example, for this memo we create a header including this information:
Date: 11/14/2003
To: <Project Contact Name>
From: Shawn Jackson

Tip: While you can create the document template directly from Export after selecting the fields to export, we 
recommend creating the document in Word first and later inserting it. This makes it easier to identify which 
fields you need to export. 
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Subject: Project performance YTD

We enclose the field name in brackets < > to designate a placeholder. These placeholders help identify 
where Financial Edge information should be inserted.

3. When you finish, save the document template in a location you can easily access again. 
4. From The Financial Edge, access General Ledger. On the navigation bar, click Export. The Export page 

appears. 
5. Click New. The Create a New Export screen appears. 

6. In the What type of export do you want to create? box, select “Project”.

7. In the Export format field, select “Blackbaud Simple Word Merge”.

Tip: You can set a default export format in Options. For more information about export options, see the 
Options chapter of the Program Basics Guide.
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8. Click Create Now. The New Project Export record screen appears displaying the Filters tab.

9. Select criteria to determine which records to include in an export. For this example we filter by a range of 
selected projects. For more information about filtering, see the Program Basics Guide.

10. Click Next or select the Output tab. The Output tab appears.

11. In the Available Fields box, a tree view lists all the criteria groups available for projects. Click the plus sign 
next to a criteria group to view all fields available for that criteria group. For more information about 
criteria groups, see “Using Criteria Groups” on page 15.
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For this example, we expand the Contacts criteria group.

12. To add fields from the tree view to the Output box, select a field and click Select. The field moves to the 
Output box. For this example, we add the Contact name field. 

13. Click OK and you return to the Output tab. The Contact Name field appears in the Output box.

14. Expand the next criteria group with fields you want to export. For this project export, we expand the 
Project criteria group.

Tip: When adding fields to the Output box, the quickest methods are to double-click fields, or to drag and drop 
fields from one box to the other.

Note: If you select a one-to-many field, enter “1” as the number to export on the output criteria screen. For 
more information about one-to-many criteria groups, see “One-to-Many Criteria Groups” on page 16. 
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15. Select a field from the criteria group to add to the Output box. For this example, we select the Project ID 
field. The Project ID field moves to the Output box.

16. Expand the next criteria group with fields you want to export. Continue until you have added all the fields 
necessary to export. For this project export, we expand the Summary criteria group and select the 
Beginning Balance, Ending Balance, and Net Activity fields. We also expand the Project budget summary 
group and add the Original project budget field.
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17. On the toolbar, click Edit merge document. Word opens automatically to a blank document to use to 
create your template document.

18. You already created the text for the document template in steps 1 through 3 — now you need to insert it 
into this blank document. From the file menu, select Insert, File. The Insert File screen appears.

19. Browse to the location where you saved the document template. Select the Word *.doc file and click 
Insert. The text for the document template appears in the new Word document.
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20. Highlight the placeholder for which you want to insert the first field of information. For this example, we 
highlight the <Project Contact Name> placeholder in the header so we can insert the Project contact 
name field in its place.

21. Once the placeholder is highlighted, click Insert Financial Edge field on the toolbar. A list of the exported 
fields appears. 
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22. Select the first field you need from the list. For this example, we select the Project contact name field. 
The program field name for Project contact name appears in the memo replacing the <Project Contact 
Name> placeholder.

23. Repeat these steps to continue placing the fields in the appropriate placeholders. For this example, we 
also add the Project ID, Beginning Balance, Ending Balance, and Original project budget fields.

24. To return to Export to continue the merge process, click Save and return to FE7 to Merge. You return to 
the New Project Export screen. 
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25. To run the merge, click Merge Now. The Export file name screen appears.

You can save the merged documents in the default location or browse to a folder in a different location 
using the Save in field. 

26. In the File name field, enter a name for the merged documents.
27. The Save as type field defaults to “Blackbaud Simple Word Merge”. Leave the data type as “Blackbaud 

Simple Word Merge”. This saves the merged documents as a *.doc file you can open in Word.
28. Click Save and a processing screen appears. Once the export is complete, a screen appears displaying the 

number of rows exported.
29. Click OK to return to the export record.
30. Before saving, you can view the merge documents and make changes to the Word document or to the 

exported data.
• To view the merged documents, open Word and then open the saved *.doc file. (You can find the *.doc 

file on the File menu list of recently saved documents.) 
• The Word document opens to the first page of the merged document. This single Word document 

contains all of the merged documents created from the export, each appearing on a separate page. 
Project-specific information now appears in each place you inserted a field name.
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• To view the other documents created, scroll down to view the next page.

31. You can edit the document directly in Word. When finished, save and close the document, exit Word, and 
return to your export record.

32. To save the export record, click Save and Close on the toolbar. The Save Export As screen appears. 
33. Enter a name and description for the export. To give others rights to run or modify this export record, 

mark Others can run this export and Others can modify this export. 
34. Click Save. The export record is saved and appears in the list on the Export page.

Creating a Conditional Word Merge

The conditional merge process is essentially the same process as a simple merge in that both use Microsoft Word 
integrated features to produce documents customized with information exported from your Financial Edge 
database. However, with the conditional merge, you can create more complex merges that use multiple 
document templates rather than a single document template. Furthermore, you can define conditional “If/Then” 
statements that determine which document a recipient should receive. 
For example, in Accounts Receivable, you need to create letters for clients with information about the upcoming 
classes they are scheduled to attend — one letter for clients attending the Family Management class, one for 
clients attending the Anger Management class, and one for clients attending the Alcohol and Drug Recovery class. 
You can create an export file of all individual clients, and using the conditional merge process, you define 
conditional statements that match each client with the letter for the class he or she is scheduled to attend. 
Furthermore, each letter is customized with information specific to its recipient, such as his or her name and 
address.
This is an overview of the process you would use to create the client letters described in the previous example:

Step 1. In Word, create three unique letters, one letter for clients attending the Family Management class, one 
for clients attending the Anger Management class, and one for clients attending the Alcohol and Drug 
Recovery class. Leave placeholders for exported information.

Tip: While you can create the document template directly from Export after selecting the fields to export, we 
recommend creating the document in Word first and later inserting it. This makes it easier to identify which 
fields you need to export. 
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Step 2. In Export, create an export file including all individual clients. Include the client’s name, address 
information, and the class he or she is scheduled to attend.

Step 3. Using the Conditional Word Merge Wizard, select the export field to use as the condition and define 
conditional statements to match recipients with the appropriate letter they should receive according to the 
class they are scheduled to attend. For this scenario, one conditional statement would be, “Use this 
document when Description is equal to Family Management”.

Step 4. Click Edit merge document to access Word. Insert the letter created for the first condition into the blank 
Word document.

Step 5. Insert the Accounts Receivable field names you selected in the export into the placeholders created for 
that information. For example, if you left a placeholder for the clients’s name, insert the Client name field 
here.

Step 6. Repeat steps 4 and 5 for the other two letters.
Step 7. Run the merge. A Word file containing the merged documents is saved in the location you designate. You 

can preview these documents and make any necessary changes before saving the export record. For 
information about editing conditional merge documents, see “Editing Conditional Word Merge Documents” 
on page 54.

Creating a conditional merge in Export
1. Once you complete the planning of your documents, open Word. 
2. Create the first document template by typing the document in Word, leaving placeholders for the fields of 

information you will add. For example, we create the first letter for clients scheduled to attend the Family 
Management class. The letter begins with a header with the client’s address and a salutation. We leave 
placeholders for the client’s name and each address field.
<Client’s name>
<Address>
<City>, <State>  <Zip>
Dear <First name>, 
We enclose the field name in brackets < > to designate a placeholder. These placeholders help identify 
where Financial Edge information should be inserted.

3. When you finish, save the document template in a location you can easily access again. 
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4. Repeat steps 2 and 3 for the other conditions in this series of documents. For this example, we also create 
document templates for clients attending the Anger Management class and those attending Alcohol and 
Drug Recovery class.

5. Open The Financial Edge to Accounts Receivable. On the navigation bar, click Export. The Export page 
appears. 

6. Click New. The Create a New Export screen appears. 

7. In the What type of export do you want to create? box, select “Client”.
8. In the Export format field, select “Blackbaud Conditional Word Merge”.
9. Click Create Now. The New Client Export record screen appears displaying the Filters tab.

Tip: You can set a default export type and export format in Options. For more information about user options, 
see the Program Basics Guide.
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10. Select criteria to determine which records to include in an export. For this example, we filter by client 
record type so the export includes only individual client records. For more information about filtering 
records, see the Program Basics Guide.

11. Click Next or select the Output tab. The Output tab appears.

12. In the Available Fields box, a tree view lists all the criteria groups available for clients. Click the plus sign 
next to a criteria group to view all of the fields available for that criteria group. For more information 
about criteria groups, see “Using Criteria Groups” on page 15.
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For this example, we expand the Client criteria group.

13. To add fields from the tree view to the Output box, select a field and click Select. The field moves to the 
Output box. For this example, we add the Client name field. The Client name field moves to the Output 
box.

14. Expand the next criteria group with fields you want to export. For this client export, we expand the 
Attributes criteria group.

Tip: When adding fields to the Output box, the quickest methods are to double-click fields, or to drag and drop 
fields from one box to the other.

Note: If any of the fields you select is a one-to-many field, enter “1” as the number to export on the output 
criteria screen. For more information about one-to-many criteria groups, see “One-to-Many Criteria Groups” 
on page 16. 
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15. Select a field from the criteria group to add to the Output box. For this example, we expand the Adult 
Education Services group and select the Description field. The Description field moves to the Output box.

16. Expand the next criteria group containing fields you want to export. Continue until you have added all the 
fields necessary to export. For this client export, we expand the Address criteria group and select the 
Address, City, State/Province, and ZIP/Postal code fields. We also expand the Name sub-group and 
select the First name field.

17. On the toolbar, click Conditional merge wizard. The Blackbaud Conditional Word Merge Wizard — Step 1 
screen appears.
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18. Select the export field from the tree view to use as the condition for the documents. For this example, we 
select the Description field found in the Adult Education Services group.

19. Click Next. The Blackbaud Conditional Word Merge Wizard — Step 2 screen appears.
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20. Click New Document. The Conditional Merge Document screen appears.

21. In the Condition field, select “equal to”.
22. In the this value field, enter the first field value to use as a condition. In this example, we enter “Family 

Management”. This will match clients scheduled to take the Family Management class with the Family 
Management letter.

23. In the Document description field, enter a name for the document. For this example, we name the 
document “Family Management”.

24. Click Edit merge document. Word opens to a blank document titled “Merge document for condition 
‘equal to Family Management’”. 
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25. You already created the text for the document template in steps 1 through 3 — now you need to insert it 
into this blank document. From the menu bar, select Insert, File. The Insert File screen appears.

26. Browse to the location where you saved the document template for the first condition. Select the Word 
*.doc file and click Insert. The text for the document template appears in the Word document.
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27. Highlight the placeholder for which you want to insert the first field of information. For this example, we 
highlight the <Client’s name> placeholder in the header so we can insert the Client name field in its place.

28. Once the placeholder is highlighted, click Insert Financial Edge field on the toolbar. A list of the exported 
fields appears. 
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29. Select the first field you need from the list. For this example, we select the Client name field. The 
program field name for Client name appears in the letter replacing the <Client’s name> placeholder.

30. Repeat these steps to continue placing fields in the appropriate placeholders. For this example, we also 
add the Address, City, State/Province, ZIP/Postal code, First name, and Description fields.

31. To return to Export to continue the merge process, click Save and return to FE7 to Merge. You return to 
the Conditional Merge Document screen. 
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32. Click OK. You return to the Blackbaud Conditional Word Merge Wizard — Step 2 screen and the new 
condition appears in the grid.

33. Click New Document. The Conditional Merge Document screen appears. Repeat steps 21 through 32 
until you have created a document for each condition. 

34. Once you have added program fields to each document template, click Finish. You return to the New 
Client Export screen.

35. Click Merge Now to run the merge. The Export file name screen appears.

You can save the merged documents in the default location, or you can browse to a folder in a different 
location using the Save in field. 

36. The conditional merge process produces a file folder that contains several files including the merged 
documents file. In the File name field, enter a name to use for both the file folder and the merged 
documents file. For this example, we enter “Letters for Adult Education Services”.

37. The Save as type field defaults to the “Blackbaud Conditional Word Merge”. Leave the data type as 
“Blackbaud Conditional Word Merge”. This saves the merged documents as a *.doc file you can open in 
Word. 

38. Click Save and a processing screen appears. Once the export is complete, a screen appears displaying the 
number of rows exported.

39. Click OK to return to the export record.
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40. You can view the merged documents and make any necessary changes to the Word document or to the 
exported data before saving the export record. To view the documents, open the file folder you just 
created. 

The folder generated by the merge process contains several files — *.doc files for each condition you 
created (named Condition_#); an *.html file named DATA that lists all the exported Financial Edge 
information included in the documents; the MERGE.doc file; and the *.doc file with the same name as the 
folder. 

41. Open the *.doc file with the same name as the folder — in this example, Adult Education Services. This 
*.doc file contains all of the merged documents created from the export, each appearing on a separate 
page. 

The Word document opens to the first of the generated documents. Client-specific information now 
appears in each place you inserted a field name.
To view the other documents created, scroll down the screen to view the next page.

42. If you need to make changes to documents, you have two options:
• If you need to make minor changes to only a few documents you can make those directly to the 

documents in Word. 
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• If you need to make the same changes to several letters, it is better to make those changes directly to 
the document template using the Conditional merge wizard. For detailed instructions, see “Editing 
Conditional Word Merge Documents” on page 54. 

43. When finished making changes, save and close the document, exit Word, and return to the export record.
To save the export record, click Save and Close on the toolbar. The Save Export As screen appears. 

44. Enter a name and description for the export. To give others rights to run or modify this export record, 
mark Others can run this report and Others can modify this report. 

45. Click Save. The export record is saved and appears in the list on the Export page.

Editing Conditional Word Merge Documents
After you run a conditional merge, you can make changes or updates as needed. If you find you need to make 
changes to multiple documents, you can make these changes directly to the document templates using the 
Conditional merge wizard.

Editing conditional Word merge documents
1. From the open *.doc file of merged documents, identify the changes that need to be made.
2. Close the *.doc file and return to the export record.
3. On the Output tab, click Conditional merge wizard. The Blackbaud Conditional Word Merge 

Wizard — Step 1 screen appears.
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4. Click Next. The Blackbaud Conditional Word Merge Wizard — Step 2 screen appears.

5. In the grid, select the document you need to edit, and click Open. The Conditional Merge Document 
screen appears.

6. Click Edit merge document. Word opens the saved merge document you selected.

7. You can edit the text of the document, fix punctuation, run the Spelling and Grammar check, and insert 
additional Financial Edge fields.

8. When you finish making changes, click Save and return to FE7 to merge. You return to the Conditional 
Merge Document screen.
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9. Click OK. You return to the Blackbaud Conditional Word Merge Wizard — Step 2 screen. From this screen 
you can select another document to edit and repeat steps 5 through 9. 

10. When you finish editing, click Finish. You return to the Output tab.
11. Click Merge Now to run the merge again and update the documents with the changes. The Export file 

name screen appears.

12. Without making changes to the file name, type, or location, click Save. This will replace the original 
merge documents with the edited versions.
Once the export is complete, a screen appears displaying the number of rows exported.

13. Click OK to return to the export record. 
14. You can now open the *.doc file to view the updated documents and make sure all the necessary changes 

were made.
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